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Introduction
In the year 2670, the United Colonies of Mankind began an effort to retake the Cradle Worlds from the
Scourge conquerors. The scale of the conflict was unlike anything known to man, and fighting quickly
grew to involve both the Post-Human Republic and Shaltari Tribes.
Military organizational structures of the day, for all involved, encouraged flexibility on the part of
commanders to respond to battlefield conditions that could change at a moment's notice. What few
constraints organizational structures did dictate would often fall by the wayside as rapid maneuver and
redeployment would force units to reorganize themselves during the brief breaks in combat, or even in
the middle of a battle.
Fighting Forces of the Reconquest aims to provide its users with a window into the organizational
structures used by all four of the warring factions, reviewing and selecting the weapons of war used by
each. It attempts to remain as accurate as possible based on available information and intelligence,
ensuring that every force structure created has at least some grounding in the reality of the Reconquest
era, and could be reasonably expected to be encountered on the battlefield.

Terminology
This guide provides a description of the operational tools available within the Fighting Forces of the
Reconquest (FFoR) system. Terminology which is used matches the UCM-standard organizational
definitions, and is used throughout. Specifically:
 Army: An operational organization for a specific engagement
 Roster: A section of an Army, commonly divided by purpose or location. Each Army must have
one or more Rosters
 Battlegroup: An purpose-driven organizational element within a Roster
 Squad: A group of combat Units, typically of the same or very similar type, which operates
together on the battlefield along with their transports
 Unit: A single combat entity - one tank, one platoon of infantry, one fighter, etc
 Element: While not strictly endorsed by the UCM, this term is used throughout to refer globally
to any of these organizational structures

Quick Start Guide
For those wishing to jump in and explore on their own, this section provides a series of quick question
and answer blocks covering how to perform most of the major tasks for army construction in FFoR.
Questions in italics indicate an area where the operation of FFoR is somewhat complex, and a more
detailed review of the manual may be beneficial.

How do I...
...add rosters to an army? You don't. Rosters are set based on the army parameters selected when you
create the army.
...know what battlegroups I can put in a roster? The colored "lights" across the top of the roster show
battlegroup slots, solid indicates a mandatory group and the dark halo indicates an optional battlegroup.
...add battlegroups? Click on the colored battlegroup indicator for the type of group you want, then
press the

button to add the group.

...add squads? Drag the desired squad from the Available Squads list, and drop it in the slot you want to
fill.
...change squad size and select transports? Use the buttons at the bottom of each squad panel.
...share transport? Right-click a squad header and select a Share Transport with... option. Both squads
must already be in the battlegroup.
...add commanders? Right-click the unit you want to put the commander in, and select them from the
menu.
...see why my army is illegal? Find the error icons (
details.

) and hover the mouse over them for specific

...make it work with a smaller screen? Use the Font and Display options in the

Settings panel.

...share an army online? Use the Copy Army to... or Generate Army QR Code options on the Edit
menu to share a text list, BBCode formatted list, or embed the full army information in a QR Code for
someone else to import to their FFoR.
...decide if different upgrades should count as different models? Use the WYSIWYG options in the
Settings panel.

Starting the program
The first step in using FFoR is to start the application. During startup, the system will check for any
software updates, and prompt you to install them if any are needed. After initialization, the basic FFoR
screen will be displayed. It is empty by default; we must create an army to get started.

Creating an Army
Select
New Army from the File menu, or use the button on the toolbar. This will display the Create
New Army Dialog, which will allow you to enter the basic information for your new army.

Step 1: The first decision in creating an army is to select a faction for the army. Once you have done so,
the other controls will be enabled.
Step 2: Next, you must define the game size and points limit. The Game Size will determine the
organizational structures which are used, and how many of each battlegroup type is allowed or
required. The Point Limit will determine how many points can be used for the army. The adjustment
arrows can be used to easily select point values at 100-point increments, but any value can be entered
into the field. Although general guidelines are provided which associate certain point limits with certain
game sizes, this is not enforced. FFoR will allow you to create a 600-point Battle or a 2,500 point
Skirmish.
Step 3: Finally, the type of army must be defined. This will determine which rosters are available for the
army. A simple army type can be selected, or the army can be defined for a specific scenario. If a
scenario is selected, the proper army type for that scenario will be determined automatically; if it is a
scenario with differences for the attacker and defender, then the role for this army can be selected as
well.
Step 4: Choose the Create button to move to the next step.

Interface Overview
Once an army has been created, we can now view the basic FFoR interface. There are four major
elements to the interface:

Army Header: The top lines for the army show the faction insignia for the army, the name of the army,
the type of army or scenario it was created for, and the information for the game size and points. The
point limit shows how many points have been used, and the total. There is also an icon to the far left,
which indicates that the army currently violates the construction rules. This will be dealt with in the
section on Correcting Issues. For now, we can ignore it.

Roster Header: Below the army header is the roster header. If the army contains multiple rosters, they
will be selectable here as tabs; if not, the sole roster will be displayed. The roster information includes
the name of the roster, any special restrictions on the roster due to the army type or scenario, an
overview of the battlegroups which are in or can be added to the roster, and the point values which are
available to the roster. As with the army header, an icon is currently displayed showing that the roster is
currently violating the rules.
Battlegroup Panel: The main focus of the window is the battlegroup panel. Once battlegroups are
added to the roster, they will be displayed here to manage the squads and units which are a part of the
groups. This area will be covered in detail in the Managing Battlegroups section.

Squad Panel: At the bottom of the main screen is the Available Squads panel. This pane will show
squads which can be added to the army. Squad management will be dealt with as part of the Managing
Squads section.

Undo/Redo Capability
The FFoR interface includes a fully-robust undo/redo capability. Any change you make to an army can
be backed up by using the
Undo action, or reaccomplished with the
Redo action. Note that this is
limited to the time the current army was started or loaded from disk; it does not persist across saves.

Managing Rosters
Roster management is limited and simple, as roster selection is fixed based on the type of army being
constructed. The most important issue to remember with regards to rosters is that if there are multiple
rosters in the army, each will have its own distinct points limit and restrictions; a common issue is to see
an error reported for the army when none is visible in the current roster.
The most important element of the roster display is the battlegroup status display. These colored
markers show the battlegroup slots for the roster, and are color coded to show the type of battlegroup.
Solid markers indicate a mandatory battlegroup - this slot must be filled with a battlegroup of the
appropriate type in order for the army to meet the rule requirements.
When an available battlegroup slot has been filled, the indicator will be marked with a check. This is the
same for both mandatory and optional battlegroups, but the system will automatically fill mandatory
slots first. The maximum number of battlegroups which the roster allows is displayed in the "Max" tag
to the right of the indicators.
Mandatory

Optional

HQ
Armor
Infantry
Special
Fleet
Filled

Managing Battlegroups
The central area of the FFoR interface is dedicated to the display and management of battlegroups. To
see the battlegroups, we must first add one. This can be done by clicking on the battlegroup indicator
for the type of battlegroup you wish to add (e.g. to add an HQ battlegroup, click one of the purple
battlegroup indicators). This will display a popup with all valid battlegroups of the appropriate type,
showing details including the type and number of squads permitted (or required) in the battlegroup.

In order to add a battlegroup to the roster, locate the desired group and click the button in the upperleft corner of the group box. If we add a Field Command battlegroup, we can see it in the battlegroups
panel, and the mandatory HQ group indicator is now marked as filled.
Each battlegroup is color-coded to indicate its type, with the name and points cost displayed to the left
side while the maximum number of squads allowed in that battlegroup is displayed on the right. If the
group is currently violating any rules, this will also be indicated on the left side. In the battlegroup panel
are a number of slots for squads to be added to the group. Each squad slot has the type displayed at the
top, defining which squads can be placed in the group. Note that there may be more squad slots than
can be filled based on the maximum for the group; this will mean that battlegroups often have unusable
squad slots within their structure. Some squad slots are required to be filled, and will be displayed with
a white background (instead of the standard gray) and labeled as required.
Battlegroups are automatically sorted top-to-bottom based on their type. This ordering matches the
display order of the indicators in the roster header, ensuring that groups will always be where you
expect them to be.
Right-clicking on the left header of a battlegroup will give a short list of management options, including
the option to rename or remove the battlegroup.
Adding squads to a battlegroup is as simple as locating the type of squad desired in the Available Squads
pane, and dragging it to an appropriate squad slot. While dragging a squad, valid slots will be
highlighted with a green halo. The desired squad can be dropped in any available squad slot, and will be
created with the minimum valid units for that squad. Once a squad has been added to the battlegroup,
it can be moved or copied to any other valid squad slot in the army. To move a squad to a different
battlegroup, drag the squad by the header. To duplicate a squad, hold the CTRL key while dragging and
dropping the squad.

Available Squad Filters
The Available Squads list can be filtered to simplify locating the type of squad desired.

Most of the options will display or hide squads based on their type, but several have more distinct
functions:

 Scenario: If selected, displays any squads which are nonstandard and unique to the selected
scenario.
 Gate: Shows or hides Shaltari Gate squads. Disabled for all non-Shaltari armies.
 All: Selecting this checkbox will either select or deselect all others, and can be used to quickly
show or hide all squads.
 Unavailable: If this box is unchecked, then squads which cannot be placed anywhere in the
current army will not be shown. It is important to note that this checks only to see if there is an
open slot for each squad; nothing validates that placing the squad would be legal. For example,
if a UCM Field Command is the only battlegroup in the army, and it already has a Kodiak ACV
and two Wolverine LAV Teams, then the Kodiak and Wolverine squads would not be shown
because there is nowhere to put them. The Rapier AA Tank Section and Falcon Gunship squads
would still be shown as there is a Support slot open, even though adding either would mean the
battlegroup had too many squads. If this option is checked, then all squads will be shown based
on other filter settings whether they can be added or not.

Managing Squads
Once a squad has been added to the army, its structure will be displayed in the main panel. The header
for a squad will display the squad name and cost, while a validation error will be displayed in the footer.
Units which are currently in the squad will be shown, and empty boxes will indicate where additional
units can be placed in the squad. The unit list can be managed by a few direct controls. Right-clicking
the header for the squad will allow you to rename the squad, remove the squad, and options to share
transport with another squad if appropriate (see Sharing Transports). The bottom left button (
used to manage the units in the squad.

)is

Pressing this button will display a popup menu with a set of options which will vary depending on the
squad structure:
 Single Unit: For squads which can contain only a single unit such as the Kodiak ACV, the button
will be disabled
 Standard Squad: For squads such as the Sabre MBT Section which can have only a single type of
unit, but allows multiples, the valid squad sizes will be displayed. The current squad size will be
indicated by a checkmark (or other icon, depending on your operating system) and the points
differential between the current size and the option will be shown
 Mixed Squad: Squads such as the Wolverine LAV Team which allow diffirent units will present a
much more extensive list of options. This will include options to add each valid unit, an option
to fill all open slots with each valid unit, an option to remove a single unit of a given type, or
remove all units in the squad. Removing a unit of a given type will remove the last unit of that
type from the squad. Right-clicking on a unit in a mixed squad will also give the option to
remove a specific unit.

Selecting Transports
The bottom right button on the unit panel (
) is used to set transport options for the squad. As with
the size control, clicking the button will display popup menu. This menu will list all possible transport
options (including no transport at all) for the squad, but can be confusing to read. For instance, if we
press the transport button for the Sabre MBT Section, one of the menu options is [6] 2x Condor (+62).
This can be broken down as follows:
 [6]: This is the squad size necessary for this transport option to be valid; in this case, it means we
would need to have 6 Sabres in the squad. Size indicators which include an S, such as [9S]
indicate that the transport may be shared with another squad, so long as the number
requirement is still met.
 2x Condor: These are the transports which will actually be selected. This option indicates a pair
of Condor medium dropships. Others may include a mix, such as a Juno A1 and Juno A2, but
those are rare.
 (+62): As with the size selection, this tells the user how much the option would cost. In this
case, it would increase the cost of the squad by 62 points.

Sharing Transports
To select a shared transport for two squads, both squads must first be added to the same battlegroup.
Right-clicking on the header for a squad will give an option to share transport with any valid squads in
the battlegroup.

Once you have selected a second squad, the two squads will be linked. They will be displayed as a single
box, with a series of link icons ( ) to indicate that the two squads are joined. The second squad will no
longer be able to select a transport; the transport for both squads will be selected from the primary
squad. As discussed above, only transport options which have the S indicator are valid as a shared
option.
When selecting squads to share transport, the selected squad will keep its current transport, while the
secondary squad will have any transport they are currently using removed. When you stop sharing
transport between two squads, again by using the right-click menu on the squad header, the main squad
will keep the selected transport and the secondary squad will now be independent, with no transport.

Managing Commanders
Commanders can be added to any unit, including transports, by right-clicking the unit. This will present
a popup menu with a list of commanders (including removing the commander from the unit) and the
points adjustment for making that selection. Once a commander has been selected, a rank icon will be
added to the unit display to show the presence of the commander, based on the CV of the commander.
CV

Icon

2
3
4
5
6

Note that FFoR does not attempt to make any assessment as to the wisdom of any particular choices,
including which units a commander should be assigned to. If your Field Marshal prefers the view from a
Wolverine, the system will not do anything to try to convince him (or you) otherwise.

Managing Upgrades
For units which can have upgrades selected, these upgrades will be shown as small buttons next to each
individual unit. Each upgrade will present a unique icon, and hovering over the button will show what
the upgrade is as well as how many points they cost. Selecting an upgrade will generally toggle only that
upgrade, but some units such as the Shaltari Yari prevent the selection of more than one upgrade.

Correcting Problems
Although some rules are proactively enforced by the FFoR system, generally users are allowed the
flexibility of creating illegal forces. If the current selections violate any rules constraints, then they will
be marked with the error icon . Hovering the mouse over this icon will give specific details about the
way in which current army is violating the rules.

Warnings will be provided for any specific element which violates the rules, and any violation which
makes an element invalid will also make parent elements invalid. For example, if a squad has a

transport selected which it cannot legally use, that squad will be considered invalid, as will the
battlegroup and roster it is a part of. Any violations anywhere in the army will mark the army as invalid.
When viewing the details for a high level violation, the system will attempt to direct you to the invalid
element.

Renaming Elements
Although units cannot be renamed, every other element in the army can be given a distinct name. For
the army and roster, right-click on the name and select the Set Name option. For battlegroups and
squads the same option is accessed by right-clicking the header. In all cases, the element name can be
returned to the default option by selecting the Reset Name option from the same menu.
While every element will have at least a default name, it is advisable to set a unique name at least for
the army, as this will make it far easier to find it again in the future.

Changing Army Size
If you decide you want to change either the points value or the game size for an army after you have
created it, the Set Game Size/Points menu option can be accessed by right-clicking on the field
displaying the size and points value, in the upper right of the display.

Managing Armies
The FFoR system provides a robust way to store your armies after they have been created, but can be
somewhat unfamiliar at first.

Saving, loading and Names
When you save an army with the Save Army operation, the current state of the army will be stored
for later retrieval. You will not be prompted for a file, filename, or save location, as all armies are stored
within the FFoR system itself. Changing the name of the army and saving it will update the name, but
otherwise replace the current army. You can later select an army to retrieve using the
function, which will show a list of all previously saved armies.

Load Army

Although FFoR doesn't require you to enter a name for your army, it is suggested that each army you
create be given a unique name to identify it with later. The load dialog will provide you with the faction,
scenario or army type, game size and points value for each army you save, a long list of "Standard Army"
entries will be difficult to sort through and find the one you're looking for.

Save as new
FFoR includes a traditional Save As operation which allows you to quickly and easily duplicate an
existing army. Simply selecting this menu item will duplicate the current army, and save it as a new
army entry. It is important to understand that although working with a new army, none of the details
have changed, including the name. If you were to attempt to load an army immediately after using this
function you would see two identical entries. To avoid confusion, it is suggested that you rename the
new army and then save it under the new name.

Delete and restore armies
When you no longer need an army list, you can delete it by loading it and then selecting Delete Army
from the File menu. You will notice that there is no prompt when you do this. This is because FFoR
stores deleted armies for several months in case you change your mind.
Using the Recover Deleted Army function on the File menu, you will be given a list of armies which have
been recently deleted. Selecting any of them will restore them to full availability. If a file is not restored
after some period of time then FFoR will clean them up and they will be permanently removed from the
disk.

Managing Collections
In addition to creating and managing army lists, FFoR allows you to specify a list of models you own. You
can then view a list of models needed for each army list, and compare it to your collections to see
whether you have all the needed models, and what you are missing if not.

Creating Collections
The collection manager can be accessed via the

Manage Collections item on the Tools menu. This

will open the manager in a new window. From here you can create a New Collection, Open
Collection, and manage your existent collections with the same functionality as for armies. Saving
collections, copying collections via
all function identically.

Save As,

Delete and Restore Deleted Collection, for example,

When you create a new collection, it won't yet have a name, but you must give it one before saving it.
Once you have created a collection, the collection manager will display a list of all models currently in
production for Dropzone Commander. Models for each faction will be placed on their own tab, and
organized by type and then alphabetically.

To the right of each model are fields for identifying the number of a given model owned, and the
number which are painted. One important detail here is that if you have a painted model, then you
obviously own it; for this reason you cannot enter a Painted value which is greater than the Owned. If
you do so, the Owned value will automatically adjust.

Army Model Lists
Once you have created an army you can check the list of models needed for that army and compare it to
a collection to ensure you have all the needed models. To do this, simply select the Check Needed
Models option from the Tools menu. This will open a dialog showing the models needed for the army.
By selecting a collection in the Check for collection field, you can compare the needed models to what
you have in a collection, and see what is missing. If the Painted option is checked, then the model list
will be compared to your list of painted models in the collection. If not, it will used the Owned counts.

List Cost
The army list management includes a calculator which will estimate the cost of the army you have built.
This cost is only an estimate based on standard MSRP from Hawk Wargames. The cost will be converted
to your selected currency based on the most recent exchange rates possible, as provided by the
European Central Bank. If you have a collection selected when you check the cost, then the cost of any
missing models will also be calculated and shown.

WYSIWYG model Management
The concept of What You See Is What You Get ("WYSIWYG") modeling in wargaming is one which will
draw diverse and even contentious opinions. While Dropzone Commander is officially a WYSIWYG
game, FFoR acknowledges that not everyone will choose to play this way, or that some players may take
additional steps such as magnetizing models to reflect multiple possible configurations. The WYSIWYG

system supports this by allowing the user to specify whether or not WYSIWYG rules should be used, up
to and including specifying them for some models but not others. Full details on configuring the
WYSIWYG settings can be found in the Customizing FFoR section.
When a model has been identified to use WYSIWYG rules, then any visible upgrades will be treated as a
different model. For instance, if you select the Condor to be WYSIWYG then there will be two model
options in your collection, one for the basic Condor, and the Condor with Missile Pods. When you view
the model list for an army the FFoR system will identify the model you need based on WYSIWYG settings
and selected upgrades, and use that model. Note that not all upgrades are visible on the model, and
therefore may not generate a new WYSIWYG option. Scourge Razorworms are an example of this.

Sharing your armies
Once you have made an army, you will undoubtedly want to take it with you or share it with your
friends. FFoR provides a number of possible options to enable this.

Printing
Printing your army list is as simple as selecting the Print option from the File menu, or using the
button on the toolbar. When you do, a dialog will give you the option to select one or more output
options.

The first four checkboxes each indicate a possible output selection.
 Army List: Prints the flat list of the army, with all relevant information such as organization,
point costs, commanders, etc.

 Stats Reference: Prints stat blocks with all information on the units included in your army. This
will include items such as upgraded weapon options if they are selected, and a commander
quick reference.
 Model List: Displays the list of models needed for this army.
 Shopping List: Using the last collection selected in the Model Listing dialog, provides a list of
models which are currently missing from the collection but needed for the army. As the name
implies, this can be used for a shopping list to complete the army. Note that if no collection was
selected in the Model Listing dialog then a shopping list will not be generated, even if it is
selected.
The final checkbox, if selected, will remember your chosen output options and use those each time you
print without further prompt. As the dialog indicates, if you change your mind later and want to change
the output settings you can do so from the Print Options in the settings. You can also reset that choice
so that you will again be prompted to select the output each time you print.

Copy Text and BBCode
If you wish to share a copy of the army list electronically, you can use the

Copy Army to Clipboard or

Copy Army BBCode to Clipboard. Both are available on either the Edit menu or the toolbar. When
selected, these operations will place the current army list, neatly formatted, onto the clipboard so that
you can then paste it into a text file, email, etc. The basic

Copy Army to Clipboard option uses plain

text, with tabs to indent and separate different elements of the list. The Copy Army BBCode to
Clipboard also copies the list, but uses standard BBCode markup to provide a more robust presentation
when pasted to an online discussion forum.

QR Code Exchange
QR Codes are a multi-dimensional barcode able to encode a surprisingly large amount of data in a black
and white grid. FFoR provides the ability to fully encode an army list within a QR code which can then
be sent to a friend or posted online. Anyone with access to the QR Code image can then import the
army list into their library of armies without needing to recreate it step by step.

Exporting
To generate a QR Code for your army, simply use the Generate Army QR Code item on the Edit
menu, or select the toolbar button. This will generate the QR Code for the current army, and do two
things with it. First, it will place the image for the QR Code on the clipboard so that you can paste it into
an email or other image-aware utility. Second, it will prompt you to select a file to save the code as an
image which can then be posted or shared as you see fit. The save operation can be canceled, which will
not create the file but will leave the image on the clipboard.

Importing
If you have a QR Code containing an FFoR army list, you can load it into FFoR one of two ways. First, if
you have an image file containing the code, you can select Import Army From QR on the Edit menu.
This will open a standard file selection dialog to allow you to select the image file, and it will be loaded
as the current army.
Alternately, if you have the QR image in another application such as a web browser, you can simply drag
the image into an open FFoR window, and it will be automatically transferred and loaded. Most
applications which handle images are aware enough to provide this capability.

Customizing FFoR
Not everyone thinks, works, or looks at things the same way. FFoR is designed to accommodate as
many different preferences as possible to make it easy for you to build and maintain your army lists.
Selecting

Settings from the Tools menu will open the preferences dialog, with four groups of options.

Font Settings
The FFoR interface uses the same stylized font that appears throughout the Dropzone Commander
rulebook. While this is flavorful, it may be too large for some screens, or may not render well on some
systems. To minimize problems with the font, you can choose from 3 fonts.

 Venus Rising, 12 point: The basic suggested font. Flavorful and compact, but will be the most
problematic font and the most likely to render poorly.

 Venus Rising, 14 point: A larger version of the Venus Rising font, using this font will obviously
require more screen space for various parts of the interface, but seems to have fewer rendering
issues than the 12 point version.
 System, 14 point: The default operating system font. Not as stylish as Venus Rising, but no
rendering problems and far more compact. Recommended primarily for users with smaller
screens or those who experience issues with the Venus Rising font.

Display Settings
The basic interface for FFoR in intended to provide a visually interesting experience for the user, but in
doing so can require a large amount of screen space. These display settings allow the user to customize
the data displayed to function more smoothly in a limited screen environment, or simply for preference.
These settings affect only the main interface, and will not affect any printing or clipboard copying
operations.

 Default names: This setting controls the display of squad names in the Available Squads panel,
and the default names for squads and battlegroups. Long names will use the full, official names
for elements, while short names will use a compressed version of the name which identifies the
element but lacks the flavor of the full name. For example, "Sabre MBT Section" vs. "Sabre
Squad".
 Unit Display: These options affect which pieces of data will be shown for each unit in a squad.
Note that it is possible to turn off all three, but doing so may make reviewing your army difficult.

Print Settings
As the name suggests, this panel contains the customizable options for printing. Note that these options
affect only printouts, and do not affect either the basic interface or any copy to clipboard operations.

 Watermarks: Each printed page can contain a watermarked image in the background. This is
optional and can be set to None, a faction logo, or the image of a specific unit. Each faction's
watermark can be set independently.
 Show unit images with stats: Stat reference blocks can include the image for the unit, or not.
Including the image is more attractive and can make it easier to find a specific unit at a glance,
but will also make the printout longer and allow fewer reference blocks per page.
 Print output options: The four options here are the same as those shown in the print output
selection dialog. Changing them here will set the default options which appear in the dialog
during the next print operation. The settings chosen in that dialog will be remembered
however, and reflected here. These options should primarily be used with the Use Default
option.
 Choose output for print: If the Use Default option is selected, then the user will not be
prompted to select print output during each print run; the system will use the options selected
in the previous checkboxes (or those chosen during the last print run). If Ask Each Time is
selected, then the output dialog will prompt the user for each print. Note that selecting the Use
these settings and don't ask again checkbox on the print dialog will select the Use Default
option on this screen.

Model Settings
Model settings manage elements which have to do with collections and model lists.

 Cost calculator currency: Allows you to select your local currency to use when checking the cost
of a list and potential missing models. For simplicity it is not comprehensive, but should provide
enough options for most players.
 Use WYSIWYG Models: These settings determine what level of WYSIWYG will be used when
generating model lists. There are three options:
o Yes: For the dedicated hobbyist, this option will treat all upgrades with different
components or visual distinctions as different models.
o No: With this setting, each model will only be considered based on its unit type, e.g. a
Condor is a Condor regardless of whether it has Missile Pods or not, and a Yari is a Yari
no matter which weapon upgrade is selected (if any). This option is for more casual
gamers, or possibly the opposite, as it will also serve well for hobbyists who take steps
to make their models modular through magnets or other means.
o Custom: When this option is selected, the underlying list of individual models will be
enabled. Each model can then be set to be WYSIWYG or not. This option may appeal to
gamers who magnetize some models but not others, don't want to worry about some
models which don't yet have upgrade parts such as the Albatross/Condor/Raven missile
pods, or might simply think WYSIWYG is worth it for some models but not others.
If the Custom options are used for a time and then the Yes or No options are selected, the individual
model settings will be remembered, but not used.
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